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Danasnje drustvo obiljezeno je naglim rastom i razvojem informacijske
tehnologije (IT), Sto je rezultiralo velikom ovisnoséu drustva, u Sirem smislu,
o znanju i kompetencijama osobe u IT podrudju. | premda ta ovisnost raste
iz dana u dan, ljudsko pravo na obrazovanje i informacije nije prosSireno i
na IT podrucje. Pojavili su se problemi koji utjeCu na drustvo u cjelini, koji
stvaraju prepreke i udaljavaju ljude od glavnog razloga i motivacije za
napredak, od prilike. Danas, biti racunalno nepismena osoba, znaci biti
osoba koja nije u mogucnosti sudjelovati u modernom drustvu, osoba bez
prilike, i unato¢ priznatoj neophodnosti i korisnosti inkluzivne informaticke
pismenosti, od strane Europske komisije, UNESCO-a, OECD-a i ostalih
relevantnih institucija, joS uvijek postoje grupe ljudi sa otezanim pristupom
osnovnoj racunalnoj naobrazbi (npr. osobe s invaliditetom, osobe s
potesko¢ama u ucenju, radnice/i migranti, nezaposlene osobe, osobe koje

Zive na udaljenim mjestima gdje nemaju pristup racunalnoj edukaciji).

Ove skripte, zajedno sa ostalim materijalom objavljenim na stranici
ITdesk.info, predstavljaju nas doprinos realizaciji i promociji ljudskog prava
na edukaciju i informacije u IT podruc¢ju. Nadamo se da ¢ée Vam ova
edukacija pomodi u savladavanju osnovnih racunalnih vjestina i s tom
nadom Zelimo Vam da naucite S$to viSe i tako postanete aktivni/a ¢lan/ica

modernog IT drustva.

Iskreno Vasi,

ITdesk.info team
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Prvi koraci u radu s racunalom
e ukljucivanje racunala
o spojiti sve komponente
o pritisnuti tipku za ukljucenje na racunalu
o eventualno upisati korisnicko ime i lozinku

e iskljucivanje rac¢unala

o T i

o pojavljuje se prozor sa opcijama:
e Pripravnost / Stand by

* Iskljucivanje / Turn Off — opcija za gasenje racunala
* Ponovo pokretanje sustava / Restart (tipka Reset na
kucistu ima istu funkciju) — opcija za gasenje i

ponovno ukljucivanje racunala

e U slucaju da neka aplikacija ne reagira =
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e Funkcija pomoci se otvara tako da
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o u polje Pretrazi / Search upisemo podrucje o kojem bismo voljeli znati vise i pritisnemo
lijevu tipku misa na strelicu pokraj polja ili pritisnemo tipku Enter

WINDOWS XP

e jedan od operativnih sustava (softvera koji korisnikove naredbe pretvara u racunalu razumljiv
jezik)

Radna povrsina (Desktop)

e podloga na kojoj se radi i koja se uvijek nalazi u pozadini, predstavlja ,,uredski stol“,
e postoje mnogi nacini da si korisnici /ce prilagode izgled radne povrsine
e nanjoj su smjestene:

o Gumb Start

o lkone

o Traka sa zadaéama (Taskbar)

Start izbornik:
e sluzi za pocetak rada odnosno biranje odredene mape ili programa
e pritisak lijeve tipke miSa na gumb > otvara se izbornik s podizbornicima:
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e ulijevom stupcu:

o precice za koriStene Internet preglednike (program kojim se pretrazuje Internet i u kojem
se otvaraju web stranice), na slici: Mozilla Firefox i Internet Explorer, program za slanje i
primanje elektronske poste (e-mail), na slici Mozilla Thunderbird

o precice za najcesce koristene programe (aplikacije, softver), na slici: FileZilla, Media Player
Classic, Notepad, itd.

o Svi programi (All Programs) — biranje i pokretanje Zeljenog programa
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e udesnom stupcu:
o Moji dokumenti (My Documents) —izravno otvaranje mape u kojoj su nam najéesce
spremljene datoteke
Moji nedavni dokumenti (My Recent Documents) — popis nedavno koriStenih datoteka
Moje slike (My Pictures) - izravno otvaranje mape gdje su nam najcesce spremljene slike

Moje racunalo (My P —— s T TR
Computer) — otvaranje &
. . * Search Reiders [T100v ({I Fokder S4tc
pregleda i pristupa do B
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Pisaci i faksovi (Printers and Faxes) — pregled i podeSavanje pisaca i faksova
Upravljacka ploca (Control panel) — podesavanje racunala

Pomoc i podrska (Help and Support) — pomoc¢ o Windows XP

TraZi (Search) — pronalaZzenje datoteka ili mapa na ¢vrstom disku, CD-u ili Internetu
Pokreni (Run) — pokretanje programa upisivanjem izvrSne datoteke

Odjavi korisnika (Log off) — odjavljivanje korisnika, ali ne i gaSenje racunala

Iskljuci racunalo (Turn Off Computer) — gasenje ili ponovno pokretanje racunala

0 O O O O O O

Ikone:
e slicice koje predstavljaju programe, programske precice, mape ili datoteke
e predefinirane ikone MS Widows-a: My Computer, My Documents, Recycle Bin
e najcesce: mape, programi za obradu teksta (OpenOffice.org Writer, Microsoft Word)

W ow B B &

r syllabus. pdf project cc.jpa tafhii.exe

Rad s ikonama
e Oznacavanje ikone: pokazivatem misa (kursorom) se pozicioniramo iznad Zeljene ikone,
pritisnemo te otpustimo lijevu tipku misa, ikona se zatim ispuni bojom, znak da je oznacena
e Pomicanje ikone (uhvati-povuci-pusti metoda, drag-and-drop):
1. pritisnemo i zadrzimo lijevu tipku misa na Zeljenoj ikoni
2. odvucemo ikonu na Zeljenu poziciju
3. otpustimo lijevu tipku misa
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e Otvaranje ikone:
o dvaput brzo pritisnemo lijevu tipku misa na ikonu, ili
o oznacimo ikonu i pritisnemo tipku Enter

Precice
e dvostrukim pritiskom na lijevu tipku misa pokrecemo ono na sto precica pokazuje
e ikona radi raspoznavanja ima strelicu u donjem lijevom kutu
e zauzima 1 kb, briSe se bez posljedica na program ili dokument na koji pokazuje

e kreiranje:
1. pritisnemo i zadrzimo desnu tipku na Zeljenom programu, mapi, datoteci
2. odvucemo je na radnu povrsinu i otpustimo desnu tipku misa
3. odaberemo Kreiraj precicu ovdje / Create Shortcut Here

Traka sa zadac¢ama (Taskbar):

) wngae - Mok fe T vmorep ey

e nalazi se na dnu radne povrsine

e prikazuje pokrenute programe, otvorene mape i datoteke, tj. ono na ¢emu i RAM trenutno
,radi

e moze se premjestati, sakriti / hide, dodavati razli¢ite programe koji se nakon toga mogu
pokrenuti i na ovaj nacin

Prozori
e svi programi i mape otvaraju se unutar pravokutnika kojeg nazivamo prozor
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5. Traka kliza¢a — horizontalna i vodoravna
6. Gumbi za minimiziranje, maksimiziranje (odnosno vracanje, ako je prozor maksimiziran) i

zatvaranje
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e Premjestanje prozora:
o pritisnemo i zadrzimo lijevu tipku misa na naslovnoj traci i pomi¢emo prozor u Zeljenom
smjeru (metoda uhvati-povuci-pusti, drag and drop)
e Promjena veliCine prozora:
o pokaziva¢ miSa smjestimo iznad ruba prozora, pritisnemo i zadrzimo lijevu tipku misa te ga
smanjimo ili pove¢amo
e Gumbi u gornjem desnom kutu prozora (manipulacijski gumbi):
(- | minimiziraj: prozor spustamo na traku sa zada¢ama
maksimiziraj: rasirimo prozor preko cijele radne povrsine
vrati (Restore Down): vraéamo prozor na veli¢inu prije maksimizacije

zatvori (Close): zatvaramo prozor

Rad s viSe prozora
e moZemo imati viSe otvorenih prozora, a samo je jedan aktivan
e aktivni prozor ima istaknuti okvir, dok neaktivni ima zasivljen
e otvoreni prozor postaje aktivan ukoliko pritisnemo lijevu tipku misa na njega
e otvoreni prozor postaje aktivan i ako pritisnemo lijevu tipku misa na njegov odsjecak na Traci
sa zadacama / Taskbar

)< et B L L o e
s et L S N
-mah SO e Wi aw
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ORGANIZACIJA PODATAKA NA RACUNALU

Uredaji za pohranu podataka
e Cvrsti disk (Hard Disk)
e Disketa (Floppy Disk)
e CD,DVD
e USB stapi¢ / USB Stick
e mrezni (online) uredaji za pohranu podataka (pogodnost pristupa, mogucnost dijeljenja
datoteka)

Rad s uredajima za pohranu podataka unutar Windows XP-a
e otvaranje prozora za prikazivanje uredaja za pohranu podataka: Start > My Computer

™ iy Compunns

.t A0 R rokiw S

X P Shared e This Comnpetton

T s st Svrvore adde S orage

*) mowero
=

e svaki uredaj posjeduje ikonu, naziv i slovo u zagradi (A, B, C, D, E...)
e Cvrsti disk (Hard Disk Drive) moZe biti jedan, moZe ih biti vise ili jedan moze biti podijeljen na
vise dijelova (particije)

A disketni pogon / Floppy

kada c¢vrsti  disk nije | kada Cvrsti disk nije podijeljen i | kada je cvrsti disk podijeljen na
podijelien i prikljucen je | priklju¢eni su DVD-ROM i CD- | dva dijela (particije) i prikljuceni su
DVD-ROM RW DVD-ROM i CD-RW
C | Cvrstidisk C Cvrsti disk C Cvrsti disk (prva particija)
D | DVD-ROM D DVD-ROM D Cvrsti disk (druga particija)
E CD-RW E DVD-ROM
F CD-RW

Datoteke i mape
e podaci na racunalu su organizirani u datoteke (Files)
o datoteka: skup digitalnih podataka koji predstavljaju konkretan sadrzaj (tekst, slika,
videozapis, program)
* odredena je imenom i ekstenzijom (produZenjima)
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» ekstenzija oznacava format datoteke (oznacava Sto datoteka sadrzi: sliku - .jpg,
word dokument - .doc, MP3 datoteku - .mp3)
e datoteke se smjestaju u mape (folders)

o mapa (ili direktorij): okvir u koji se smjeStaju datoteke ili druge mape radi bolje organizacije
i preglednosti

o glavna mapa moZe sadrzavati podmape, koje mogu imati svoje podmape, u kojima se
mogu nalaziti podmape... - grananje mapa

o Path —put do Zeljene mape odnosno datoteke
ukoliko u prozoru mapa odaberemo alat Mape (Folders) prikazuje se Windows Explorer
pogled

o na lijevoj strani pojavljuje se hijerarhijska struktura

™ My Computer

Fle EQ Vew Faworkes Todks Meb r

Search | [ Feidees | (137 (ID Folder Syne

Thumbruds

x e * u:. L—vultv
-

ot aly vt

= —

| edowring's Documents

| User's Coouments

—

Hard Dk Dvives

& ) User's Doouments
S My Nstwork Places
£ Recyde B0

E;’,xsz—)‘._:

Devices with Removalide Storage

= ‘ shorage (D)

¥ ) 211, edederdo

- 1234 S~

L) 169, deeld | el H 3.5 Fegey (&) : o v 05 2080 ()
™ ks ]

L deshtop
a1 ecd advenced syfabe and tests > )

a <O Dvive (F2)
) tleareg W

) whorret (el NG

LD Inkerret s mal HRY
L2 1Y poprovi KNG | 16V
d [Tdesi rfo precentatie
2 KONTENER V7 vchame b 2
< >

Rad s datotekama i mapama u Windows Exploreru
¢ hijerarhijski prikazuje mape i datoteke unutar uredaja za pohranu podataka

Start > All porgrams > Accessories > Windows Explorer ili desna tipka miSem na Start >
Explore

rad u lijevom prozoru:
prikazuje cjelokupnu strukturu mapa, olakSava navigaciju
+ mape se dodatno granaju
— mape su razgranate

O O O O

pritisnemo li lijevu tipku miSa na mapu i u desnom prozoru se pokazuje sadrzaj

rad u desnom prozoru:
o mape otvaramo dvoklikom lijeve tipke
* Naziv (Name) — popisane su datoteke i mape po nazivima
* Velic¢ina (Size) — velicina mapa i datoteka
* Vrsta (Type) — tip datoteke
* Promjene (Date Modified) — datum zadnje promjene na datoteci
» Statusna traka —na dnu prozora, informacije o mapi ili datoteci
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Stvaranje mapa i podmapa
e preko Windows Explorera: u lijevom prozoru ozna¢imo mapu u kojoj Zelimo stvoriti novu
mapu i:
o natracisizbornicima odaberemo File, zatim New > Folder > UpiSemo ime > Enter ili
o pritisnemo desnu tipku misa u desnom prozoru > New > Folder > UpiSemo ime > Enter

Prikaz imena, veliCine i lokacije mape i podmape
e prikaz se mozZe mijenjati na alatnoj traci preko alata View / Prikaz, a opcije su:

o Minijature (Thumbnails)
o Plocice (Tiles) (na slici ispod)
o lkone (Icons)
o Popis (List)
o Detalji (Details)
e Svaka datoteka i mapa ima Svojstva / Properties  Open N
. o . . Explor
o desna tipka misem na datoteku otvara brzi izbornik te gm‘;now.s“moy
H Search, .
odaberemo Svojstva PR TP rORUr IR
o prikazuje se lokacija, veli¢ina, datum kreiranja, 72p ’
promjene, autor itd. Sharing and Securky ...
) Power[SO >
O SoatFTP »
PwinZp ’
A Groave Folder Synchroncstion »
s FroeAre »
%3 5can selected files with Antive
Send To »
e
Copy
Create Shortok
Delete
Rename
Propertes
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Datoteke i mape mozemo skrivati:
e desna tipka miSa na datoteku ili mapu > Properties > na kartici General > Hidden > Apply > OK
e pojavljuje se dijaloski okvir Potvrdi promjene svojstva / Confirm Attribute Changes sa
opcijama:
o Primjeni promjene samo na ovu mapu / Apply changes to this folder only
o Primjeni promjene na ovu mapu, podmape i datoteke / Apply changes to this folder,
subfolders and files

Geowrdl | Sharrg - Customce

/‘ s Confirm Attribute Changes

Type Fie Foldes You have chosen to make the following sttribute changes:

Locaton C\Documents and Settngs\User\Desidop hide

Sas Z50KB (26127 bytes) DO you wank to apply this change to this foldar only, or 4o you wank to
2pply & 2o of subfolders and fles a5 well?

Swe onditk. 260 KB (266240 bytes)
6 Fies, 0 Foldess O Apply changes to this folder only
(2 Apply changes to this folder, sublolders and files

Cortams

Created 20 veista 2010, 04805

Atideter  [B) Readcely l:_;“i’”.i‘“‘

(] Hidden

l oK ] r_Cencd

[ox ][ cComel J[ o0y ]

e Skrivene mape i datoteke mozemo uciniti vidljivima:
o Tools > Folder Options > View > ukljuciti Show hidden files and folders; Apply > OK

Promjena statusa datoteke
e datoteke moZemo otvoriti, modificirati i obrisati, osim ako nije drukcije zadano u njenim
Svojstvima /Properties

o ako Zelimo datoteci promijeniti status tako da bude dostupna samo za Citanje (Read Only):
na kartici Svojstva / Properties pritisnemo lijevu tipku misa u potvrdi okvir (kvadratic),
pokraj Read Only atributa, ¢ime se u njemu pojavljuje kvacica. Potvrdimo promjenu
gumbom Primjeni / Apply i na kraju gumbom OK.

o kad Zelimo opet promijeniti status datoteci, ponovno pritisnemo lijevu tipku misa u isti
potvrdi okvir dok on ne postane opet prazan;,potvrdimo promjenu gumbom Primjeni /
Apply i na kraju gumbom OK.
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Prikaz ekstenzija datoteka Tolder Optiens ? %
e datoteke imaju ekstenzije — nastavak na ime el Vo Fie Typms | Ctire ey
odvojen tockom, koje odreduju tip datoteke, tj. koji
¢e program otvoriti datoteku ako dvostruko
kliknemo na nju

O S aechy B viewe [ouch ae Detade & Tt 09
— POu e g for B Sokder %o o Mok

| Acchy 4 M T otiecy Foaunt ALF i

o prikaz ekstenzije: otvorimo izbornik Alati / Tools, i Ao sl

Dagbar srvpie Ackdet v 1 € apiorer's F e be »~

odaberemo Folder Options; otvorimo karticu Deglar $ue comarés of asem hile

v, Daghay B A2 20 1 e 200et bw

Pogledi/ View i kliknemo na potvrdni okvir (time UIATORAS IR o S

uklonimo kvaticu) pokraj opcije Hide extensions ™ 05 Dt s b it ke
for known file types. Potvdimo promjenu i meymrre e
gumbom Primjeni / Apply i na kraju gumbom OK.

o sakrivanje ekstenzije: postavimo kvacicu u

+ Made pestecied qoer s vk

Lawed W snkwns » »

ya
o Marageg pas of 'Web pages and ke -

potvrdni okvir (ponovno klikanjem na njega) | SemmPrel
pokraj opcije Hide extensions for known file types ok || Conew
Najcesée koristene datoteke:

OpenOffice.org paket uredskih programa Ekstenzija:

tekstualni dokument: Writer .odt

izrada i pregled prezentacija: Impress .odp

rad s tablicnim kalkulatorom: Calc .ods

Ekstenzija:
verzija 2003 verzija 2010

Microsoft Office

tekstualni dokument: Word dokument .doc .docx

izrada i pregled prezentacija: PowerPoint prezentacija .ppt .pptx

rad s tablicnim kalkulatorom: Excel dokument Xls Xlsx

Ostali programi: Ekstenzija:
glazbeni zapis .mp3

slika Jjpg

video zapis .mpeg
komprimiran (sazZet) sadrzaj .Zip
izvrSna datoteka (program) .exe

Preimenovanje datoteka i mapa

e desna tipka miSem na datoteku ili mapu > Preimenuj / Rename > UpiSemo novo ime i
pritisnemo Enter

e potrebno je paziti da ne promijenimo i ekstenziju jer inace moZda vise ne mozemo otvoriti
datoteku

Oznacavanje mapa i datoteka (selektiranje)
e jednu — pritisnemo lijevom tipkom misa na datoteku
e viSe u nizu — pritisnemo lijevom tipkom misa na prvu > pritisnemo i zadrzimo tipku Shift +
pritisnemo lijevom tipkom misa na posljednju, otpustimo tipku Shift
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e viSe koje nisu u nizu — pritisnemo lijevom tipkom misa na prvu, pritisnemo i zadrzimo tipku
Ctrl + pritisnemo lijevom tipkom misa na ostale datoteke ili mape
e oznacavanje svih datoteka unutar odredene mape: Edit > Select All ili Ctrl + A

Prebrojavanje datoteka
e prebrojavanje unutar mape: desna tipka misem na mapu > Svojstva / Properties > vidimo
koliko mapa sadrzi datoteka i podmapa
e prebrojavanje datoteka istog tipa: Prikaz / View > Detalji / Details > prikaz Type > Oznadimo
datoteke iste vrste > u statusnoj traci piSe njihov broj

UmnoZavanje datoteka ili mapa (kopiranje):
1. oznacimo datoteku ili mapu koju Zelimo kopirati

2. pritisnemo desnu tipku misa i na izborniku odaberemo alat Kopiraj (Copy) i=2 (Ctrl + C)
3. postavimo pokaziva¢ misa na mjesto gdje Zelimo smjestiti kopiju
4

pritisnemo desnu tipku misa i na izborniku odaberemo alat Zalijepi (Paste) I (Ctrl + V)

Kopiranje pomocu uhvati — vuci — pusti (Drag and drop)
1. oznacimo datoteku ili mapu koju Zelimo kopirati
2. na oznacenoj datoteci ili mapi pritisnemo i zadrzimo lijevu tipku misa te pritisnemo i
zadrzimo tipku Ctrl
3. vucemo pokaziva¢ misa
4. otpustimo tipku misa i potom tipku Ctrl. Kopija je zalijepljena na novu poziciju.

Premjestanje datoteka ili mapa:
1. oznacimo datoteku ili mapu koju Zelimo premjestiti

2. pritisnemo desnu tipku misa i na izborniku odaberemo alat lzrezi (Cut) & (Ctrl +X)
3. postavimo pokaziva¢ misa na mjesto gdje Zelimo premjestiti datoteku ili mapu

4. pritisnemo desnu tipku misa i na izborniku odaberemo alat Zalijepi (Paste) b (Ctrl +V)
Premjestanje pomocu uhvati — vuci — pusti: kao i kopiranje, ali bez tipke Ctrl

Brisanje datoteka i mapa
e Windows Explorer > u lijevom prozoru ozna¢imo mapu u kojoj se nalazi datoteka ili mapa > u
desnom prozoru oznacdimo datoteku ili mapu koju Zelimo obrisati > File > Delete
e pritisnemo desnu tipku misa na mapu ili datoteku i na izborniku odaberemo alat Delete
e pritisnemo desnu tipku misa i na izborniku odaberemo alat Delete
e pritisnemo i zadrzimo lijevu tipku misa na datoteci ili mapi koju Zelimo obrisati, odvu¢emo
pokaziva¢ misa do Smeca / Recycle Bin (metoda uhvati-povuci-pusti, Drag and Drop)

Vradanje datoteka i mapa
e obrisano odlazi u Ko$ za smece / Recycle Bin
e opcije:
o isprazni Kos za smece / Empty the Recycle Bin
o vrati sve natrag / Restore all items
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e vracanje natrag jedne datoteke: pritisnemo desnu tipku misa na nju i na izborniku
odaberemo naredbu Vrati / Restore

»

’ Fie Edt View Favotes Toos Hep @
\ : T seun Fodes [aile R Folde Sye
‘e
=2gonm S o Dicke Defeted
foecyche Dir ¥ asks natariad CADocsrarts and Settngline 16.3.10 1903
= - - CADoournerts and Settngsliise 10.3.10 15491
Ty o S LA — o N -
é’ - G e Mcrozoft Office Access 2007 Databese . acodd Cifocuments and Sattng=ilise 10,310 1895
watzre @ b
Orher Places
(@ twitr
o) My Ducaverts
* Wy Carputer
‘i A A
< >

Komprimiranje datoteka i mapa (sazimanje)
e komprimiranjem se smanjuje prostor koji ti podaci zauzimaju na disku
e pritisnemo desnu tipku misa na datoteku ili mapu i na izborniku odaberemo naredbu Send to
(posalji) > Compressed (zipped) Folder (Komprimirana (zipana) mapa)

¢ dodavanje datoteka i mapa: metodom uhvati-povuci-pusti (drag and drop) na mapu
e programi za komprimiranje: Win Zip, Win Rar

Dekomprimiranje (raspakiravanje) komprimiranih mapa i datoteka (extract)
e da bi mogli modificirati komprimirane

datoteke ili mape potrebno ih je

B = Frechrc ’

dekomprimirati Y curBilortud i Wi Al
@ winZip »
e pritisnemo desnu tipku misa na _ _—s :T:;:'
n xXr ! 5.0
komprimiranu mapu ili datoteku > €)PowerIsO N Eracthee 0 |
Extract to “report|”
odaberemo program za dekompresiju oodiczenioli Test archive
. .. . v - Send To » Add to archive...
> odredimo lokaciju gdje Zelimo - Cotoeia and aaiad...
at s Add to “report 7"
spremltl mapu Copy Compress to “report. 72" and emal
Creste Shortout Add to “report.zip”
Dedate Compeess to report.2ip” and amal
Rename
Properties

Pretrazivanje (Search)
e Koristimo kada Zelimo pronaci nesto Sto smo zaboravili gdje smo spremili
e Start > Search > Odabir $to Zelimo pretrazZivati (slike, glazbu, video, dokumente, sve datoteke
i mape, printere...)
e Najcesée odaberemo All Files and Folders i odredimo podesenja

@@@ ITdesk.info is licensed under a Creative Commons Attribution-
@ Noncommercial-No Derivative Works 3.0 Croatia License. 12/20



http://creativecommons.org/licenses/by-nc-nd/3.0/hr/
http://creativecommons.org/licenses/by-nc-nd/3.0/hr/

ITdesk.info — projekt racunalne e-edukacije sa slobodnim pristupom

B Search Results

File Edit View Favorites Tools Help

O 0 3[pms

hi Folders ' [E:; Folder Sync

Address d Search Results

Search Companion X Name

What do you want to
search for?

Pictures, music, or video

Documents (word
processing, spreadsheet,
etc.)

Al files and Folders
Computers or people

©) Information in Help and
Support Center

You may also want to...
Q Search the Internet
Change preferences

Sortiranje datoteka
e U prikazu Detalji / Details (na slici ispod)

Fle Edt View Favortes Tooks FHelp

) ) T Osexch [ orides [T K8 Foider Sy

Address | LD CiDocuments and Settings\UserDesitoplreport

Name

File and Folder Tasks B Fp)france. acod

(5] Open Source tx2

Other Places ™ logo.109
Hoeveioping_Coursews...
A Conrsamars Evatistio. ..
" tables, pof

Lmaterssl

Detods

report
File Folder

Date Modfied: 10. obujak 2010,
19:41

e
18
0K

778
461 KB
1135 K8

Type

Shortas

Texk Dacumeart
FG Fle

Mcrozoft Office Wo...
Mcrosoft Office Exc..,

Fle Folder

In Folder

" To start your search, follow the instructions in the left pane.

Date Modfied
10.3.10 18:59
10.3.10 18:45
7.3.1017:37
2421101958
24.2.1019:57
30.1.10 19:29
291101337

e pokraj kriterija sortiranja se nalazi sivi trokut, koji pokazuje i je li sortiranje uzlazno ili silazno

e vrste sortiranja:

Ime / Name

Velidina / Size

Vrsta / Type

Datum izmjene / Date modified

O O O O

UPRAVLIJANIE ISPISOM

Promjena zadanog pisaca

¢ ukoliko postoji viSe pisaca, samo je jedan glavni koji automatski preuzima sve naredbe ispisa

e promjena: Start > Printers and Faxes > ozna¢imo printer > pritisnemo desnu tipku misa > Set

as default
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" Printers and Faxes c E &‘

Flo Edt Vew Favortes Tools MHebp vll

Qw- D T ewer [ oroses [TH- KD Foder Sy

S Preters and Fases v Bs

Printer Tasks

i ol CANYAS PS
y A Open
Set a5 Def 2l Prictes I "

\@ sacsoit s Precng Preferences...  lsand To OneNote 2007
w Pause Prioting
Sharmg.,
& Thre s prrter Croste Shortos
W) Fensms the proter Delete
9 Delete tys prictar Ferame
“"' t perdor progecties Frogertes

Other Places

B Control Pacel

Instaliranje novog pisaca na racunalo
e Start > Printers and Faxes > Add printer, ili
e preko instalacijskog CD-a pisaca
Ispis dokumenata iz aplikacije za obradu teksta
e naizborniku Datoteka / File odaberemo Ispis / Print; podesimo Zeljene postavke (broj kopija,
ispis odredenih stranica) i pritisnemo gumb OK

Prinker

Marne: ;,f Microsoft XPS Document \Wriker A | [ Properties ]
Status:  Idle Find Printer ...
Type: Microsoft ¥PS Document YWriter

Where:  ¥PSPart: [ Print to file
Comment: [] Manual duplex
Page range Copies

@ al Mumber of copies:

O Current page
O Pages: [¥] Collate
Tvpe page numbers and,l'or page

ranges separated by commas counting
Fram the start of the document or the
section. For example, type 1, 3, 5-12
ot plsl, pls2, pls3—p8s3

Print what: |D0cument L d | Zoam
Prink: |.ﬁ.|| pages in range w | Pages per sheet: | 1 pags h |
Scale to paper size: |No Scaling ~ |
Options. .. [ a4 l ’ Cancel ]

e tijekom ispisa na Traci sa zada¢ama / Taskbar se pojavi ikona printera > dvostruki pritisak
lijevom tipkom mi$a na nju i otvaraju nam se svi poslovi ispisa

e dvostruki pritisak lijevom tipkom mi$a na ikonu printera na Traci sa zada¢dama, odaberemo
posao koji Zelimo prekinuti ili pauzirati tako da pritisnemo desnu tipku misa na njega i
odaberemo Otkazi / Cancel ili Pauziraj / Pause
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KORISTENJE PROGRAMA

Rad s programima unutar operativnog sustava Windows XP

e Start > All Programs > Accessories:

o Bojanje (Paint)
e program za crtanje i slikanje te
jednostavniju obradu fotografija
o Blok za pisanje (Notepad)
e program za jednostavno pisanje
s osnovnim oblikovanjima
o Kalkulator (Calculator)

ER Ve I

) Commuricabions
) Ercertalresert
) System Tools

o) Addess Book

o Colodator

B Comenand Proengt
¥ Botepad

X)) Progyan Compalblty Waad
W) Symehecone

& Towr Wndows P

ud Wirdowes Explores

B Windows Sedebar

A4 Weebad

A Remote Deshtop Connechon

Rad s programom za obradu teksta (OpenOffice Writer, Microsoft Office Word)

e kod prve pohrane dokumenta: na izborniku Datoteka /File odaberemo Spremi kao / Save as i

u dijaloskom okviru koji se pojavi, odredimo mjesto spremanja: Spremi u / Save in te

unesemo ime datoteke, na kraju pritisnemo gumb Spremi / Save

Formatiranje medija za pohranu podataka (disketa, memorijski stapi¢ [ 3
(memory stick), tvrdi disk (hard disk) isl.) ot -
e potpuno brisanje i ponovno pripremanje za rad it
e U prozoru My Computer pritisnemo desnu tipku misa na ono Sto se ;‘,..m., -
Zeli formatirati i odaberemo opciju Format, te pritisnemo gumb OK 'm_; .
e podaci na formatiranom disku su nepovratno izbrisani pa je =
poZeljno napraviti kopiju prije formatiranja oA
e ukoliko ste greSkom formatirali medij te time izbrisali podatke,
podatke je mogude vratiti pomocu specijaliziranih programa te Vam
savjetujemo da se obratite ra¢unalnom struénjaku am ][ _cem

Antivirusni program (Norton, McAfee, Sophos)

e program koji se koristi za zastitu od racunalnih virusa

e natraci sa zada¢ama nalazi se ikona instaliranog antivirusnog programa, desnom tipkom

misa na tu ikonu pojavljuje se opcija za aZuriranje programa Start update

Koristenje ispisa ekrana (Print Screen)

e koristi se kad ekran koji trenutno vidimo Zelimo spremiti kao sliku

e pritisnemo tipku PrtSc (puni naziv: Print Screen) na tipkovnici

e otvorimo aplikaciju gdje Zelimo spremiti sliku npr. OpenOffice Writer, Microsoft Word, MS

Paint
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e alatom Zalijepi / Paste postavljamo sliku na zeljeno mjesto

Upravljacka ploca (Control panel)

¥ Control Panel

Fle [k Yew Faevortes Took PMeb

e za podesavanja

B} &) O T sy [ pases T ) Fokder e
rada racunala, T y——
ikona se nalazi na — -
. . St Fa Pick a category
startnom izborniku ehts Clss
. '-' 1
. Agpearsace and Themes Mot ers and Other Hardwarw
e pogledi: N < .,
o po kategorijama 4 Windowa $iiste “ ~a
. W) b el Sgpert 'ﬂ‘? Network sl Mternet Conmections - ? Usey Accumnky
/ Category view © it Cortre Puesl -~
xixtn
o klasi¢an pogled/ ? e T Dt T Ut 444 oyonl

Classic view
- f} Sounds, Speach, and Awlo Devices

N
A |
y Performance and Mant ensnce v'.\y

Dobivanje osnovnih sistemskih informacija:

System
e na klasicnom pogledu otvorimo ikonu g

Promjena slike na radnoj povrsini
e moZemo postaviti bilo koju sliku pohranjenu na racunalo kao sliku na radnoj povrsini
e na Upravljackoj ploci otvorimo ikonu Prikaz / Display ili pritisnemo desnu tipku misa bilo gdje
na radnoj povrsini (ne na ikonu!) i odaberemo Svojstva / Properties na brzom izborniku

Arrangs Tcons By »
Refrosh

Paste
Paste Shortost

NVIDIA Control Panel

& Groove Folder Syncheorizstion »
New »

Themes | Deshiop Sereen Saver | Appemance | Settngn

e na kartici Desktop na dijelu Pozadina /
Background odaberemo sliku. Potvrdimo
promjenu gumbom Primjeni / Apply i pritisnemo
gumb OK.

e odabirom gumba Browse odabiremo sliku bilo
gdje na racunalu
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Podesavanje Cuvara zaslona (Screen Saver)

Display Properties
Themes | Deckiop  Screen Saver  Apcesance | Setings

MOr LVt

Mugaee w | Seftings
W +  mwntes [V] 0n sesume, deglyy Welcone scieen

Mondot pomeer

To achust mondor power settngs and save enengy.
clck Povest

[_Powee_|

o J[ coce J[ 2o |

Promjena rezolucije ekrana

e piksel (eng. pixel = picture element) je osnovni
element od koje se sastoji slika na zaslonu
monitora. Za monitor koji mozZe prikazati vise
tocaka kazemo da je njegova slika bolja tj.
kvalitetnija. Kvalitetu slike monitora opisujemo
pojmom rezolucija ili razlucivost.

e rezolucija ekrana ovisi o kvaliteti monitora i
graficke kartice

e na Upravljackoj ploci otvorimo ikonu Prikaz /
Display i na kartici Settings u dijelu Screen

Resolution pomicemo kliza¢. Potvrdimo promjenu

gumbom Primjeni / Apply i pritisnemo gumb OK

Promjena vremena i datuma

Date and Time Properties rz_ E] ¢

Date & Teme | Time Zone © Inbeenet Tive

Cate Tere

travary ¥ | 2010

i 3 ] .
$ 6 7 8 9 10Mn
12 13 14 15 @ 17 18
1920 2 20NN
%8BI W
| 12:3:57 B

Currert tme 20w Contral Europedn Standard Time

Lo J[ comd J[ ot |

dinami¢nom slikom stiti se monitor, prekida
se pomakom misa ili dodirom tipkovnice

na Upravljackoj plo¢i otvorimo ikonu Prikaz /
Display i na kartici Screen Saver odaberemo jedan od
ponudenih

v

Cuvara zaslona a u polju Wait

odredujemo vrijeme koje treba proci bez pomicanja
miSa da bi se cuvar zaslona ukljudio. Potvrdimo
promjenu gumbom Primjeni / Apply i pritisnemo
gumb OK.

splay Properties X

Thermes | Deskiop  Scosen Saver | Appeararce | Selirgs

Diag the mordor o0 to match the plyscal aangenent of your Do

Diplay
1 SpreMasta TZ60,SprcH aster Magye T25010ata] on NVTILA GeFo w0
Screen sk son Color qualey
Lew : Moe Higtws! (32 t4) -

1280 Ly 1024 oo

Idertty || Trotheshoor. | | Advanced |

ox ) [ Coodl J[_ 2oy |

sa zadac¢ama

Start > Upravljacka plo¢a > Datum i vrijeme
(Start > Control panel > Date and Time), ili dvostruki
. jeneera pritisak na lijevu tipku misa na sat u desnom kutu trake

e nakon unesenih promjena datuma i vremena,
obavezno potvrdimo unos (gumb Primjeni / Apply) i
zatim gumb OK
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Deinstaliranje programa

S Ad4 or Remave Progsmm

o T .
na UpraVIJaCkOJ L 4} Curvertly retaled v oy ad L] Show oguss Srthy: | Pragarcy of tee ¥
ploci otvorimo Qe | g e e ity A

y
ikonu Frogrome I Acrot com Used rredy
Aderber Flashs Plapes 10 AdtiveX
Add/Remove ¥
/ ’ ”;:_ S here L ncoml rlorastun,
odaberemo Progien
.. Tn v Ses Progrms from pons congates, Chcs Hamwimm
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Instaliranje novih programa
e novi programi isporucuju se na CD, DVD ili ih imamo u mapi na rac¢unalu
e pokrecemo instalaciju dvostrukim pritiskom na setup.exe ili install.exe
e pokreée se Carobnjak za instalaciju, a mi eventualno odabiremo Next, Yes ili upisujemo
serijski broj

% Add or Remove Programs

k;;T ASE & peogy s From CO-ROM or Floppy dsh
Clienge or .':“l‘_' To 0cd & prograes Froes & CO-ROM or Nopgry dek, cick, CO or Flogpy [@an
%4

Add progy ame from Microsoft
» 1 ﬂ To add rew Windows festures, device drivars, and system Lpdates over the Irtermet, cich Windows Lipdate Sows Lot

Set Prograe
Def ks

Postavke i promjene jezika na tipkovnici
e operativni sustav Windows ima podrsku za veliku vecinu sluzbenih jezika
e na Upravljackoj plo¢i otvorimo ikonu Regional and Language Options > Languages > Details
¢ ako nije ponuden dodamo Zeljeni jezik opcija Add

Podesavanje brzine dvostrukog pritiska lijeve tipke misa
e Start > Control Panel > Mouse > Buttons > Double-click speed > pomicemo kliza¢ > Apply >
OK

PodesSavanje zvuka i zvu¢nika
e na Upravljackoj ploci otvorimo ikonu Sound, napravimo Zeljena podesSenja i pritisnemo gumb
OK
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Ova skripta je namijenjena za u€enje uz materijale
objavljene na slijede¢im linkovima:

* Prirucnik:
http://www.itdesk.info/prirucnik koristenje racunala upravljanje datotekama.pdf

* Video prezentacije koje prikazuju osnovno koristenje rac¢unala i upravljanje datotekama:
e http://www.itdesk.info/hrvatski/osnove-racunala-1/

e http://www.itdesk.info/hrvatski/osnove-racunala-2/

e http://www.itdesk.info/hrvatski/osnove-racunala-3/

* Probni ispit:
http://www.itdesk.info/primjeri ispita/primjer ispita modul 2.pdf

* Video-prezentacija koja prikazuje rjeSavanje primjera ispita:
http://www.itdesk.info/hrvatski/koristenje-racunala-upravljanje-datotekama-video-rjiesenje-

ispita/

* Kvizevi koji korisnici/ce sami rieSavaju:
e http://www.itdesk.info/hrvatski/koristenje-racunala-upravljanje-datotekama-kviz-1/

e http://www.itdesk.info/hrvatski/koristenje-racunala-upravljanje-datotekama-kviz-2/
e http://www.itdesk.info/hrvatski/koristenje-racunala-upravljanje-datotekama-kviz-3/

(za otvaranje linka koji se nalazi unutar PDF dokumenta samo pritisnite lijevu tipku misa na jedan od
navedenih linkova. Web stranica na koju link pokazuje ée se otvoriti u Internet pregledniku koji imate
instaliran na racunalu.)
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Op¢i uvjeti koristenja:

Web stranicu www.ITdesk.info je pokrenula udruga ,,Otvoreno drustvo za razmjenu
ideja - ODRAZI* u sklopu aktivnog promoviranja ljudskog prava na slobodan
pristup informacijama te ljudskog prava na edukaciju.

Slobodno kopirajte i distribuirajte ovaj dokument, uz uvjet da ne mijenjate nista u
njemu!

Nad svim programima i uslugama navedenim na web stranici ITdesk Home na web adresi ITdesk.info
isklju¢ivo pravo posjeduju njihovi autori/ce. Microsoft, Windows, i Windowsxx su registrirani zastitni
znakovi tvrtke Microsoft Corporation. Ostali zastitni znaci koristeni na ITdesk Home Web stranicama
su isklju¢ivo vlasni$tvo njihovih vlasnika/ca. Ukoliko imate pitanja vezana uz uporabu il
redistribuciju bilo kojeg programa, molimo kontaktirajte autore/ice doticnog programa. Sva dodatna
pitanja posaljite na info@itdesk.info.

Ove web stranice sadrzavaju linkove na ostale web stranice ili izvore. ITdesk.info team NIJE
odgovoran za tekstualni i/ili reklamni sadrzaj, odnosno za proizvode koji su na tim web
stranicama/izvorima ponudeni, kao §to NIJE odgovoran niti za sadrZaj koji je putem njih dostupan;
mogucénost koriStenja ili tocnost sadrzaja. Linkove koristite na vlastitu odgovornost. Takoder,
ITdesk.info team ne garantira:

da je sadrzaj na ovim web stranicama osloboden od pogresaka ili pogodan za svaku svrhu,
da ¢e ove web stranice ili web usluge funkcionirati bez pogresaka ili prekida,

da ¢e biti odgovarajuéi za vase potrebe,

da implementacija takvog sadrZaja nee naruSavati patente, autorska prava, zastitni znak ili
ostala prava neke trece strane.

Ukoliko se ne slazete s ovim opéim uvjetima koristenja ili ako niste zadovoljni web stranicama koje
pruzamo, prekinite s koriStenjem ovih web stranica i web usluga. ITdesk.info team nije odgovoran
vama, niti tre¢im osobama za bilo koju nastalu Stetu, bila ona direktna, indirektna, slucajna ili
posljedi¢na, povezana s vaSom uporabom ili proizlazila iz vase uporabe, pogre$ne uporabe ovih web
stranica ili web usluga. lako vaSe potrazivanje moze biti bazirano na garanciji, ugovoru, prekrsaju ili
nekom drugom pravnom uporistu, neovisno o nasoj obavijestenosti o0 moguénosti nastanka takve Stete,
oslobadamo se svake odgovornosti. Prihva¢anje ograni¢enja nase odgovornosti nuzan je preduvijet
koriStenja ovih web stranica i web usluga

Svi softveri navedeni u ovom ili drugim dokumentima objavljenim na stranici ITdesk.info su navedeni
samo za edukativne svrhe ili kao primjer te mi, na bilo koji nacin, ne preferiramo navedeni softver u
odnosu na neki drugi softver. Bilo koju izjavu da neki navedeni softver preferiramo vise u odnosu na
drugi, koji se spominje ili ne spominje u materijalima, smatrat ¢e se kao lazni iskaz. Nasu izravnu i
bezrezervnu podrsku imaju jedino softveri otvorenog koda (open source) koji omogucuju
korisnicima/cama da bez prepreka postanu digitalno pismeni, koriste racunalo i sudjeluju u modernom
informatickom drustvu.
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